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INTRODUCTION

The whole difference between
construction and creation is
exactly this: that a thing con-
structed can only be loved after
it is constructed: but a thing
created is loved before it exists.

— G. K. Chesterton

Welcome tothe A-Train Construction Set, where you can carve every
detail of your trains’ terrain. With the Construction Set, you can take
any of A-Train’s existing landscapes and mold it to your pleasure—
sculpt massive mountains, plant tiny trees, place offices on islands—
until your map is precisely the way you want it to be. You can even
completely obliterate every detail of a map—Iike a wheat farm after
a locust swarm—and build everything from the ground up. Allocate
the cash reserve you think you deserve, put in an additional railroad
or two, and load your new map into A-Train.

You can customize the challenges that different maps present in an
intriguing way: research the original New Orleans streetcar system
(if you desire), get looped in Chicago—even design a map after your
hometown! The Construction Set lets you draft landforms and cities
to experiment with form and function, or just for the sheer creative
pleasure of it. Exchange maps with other users, design different
difficulty scales, or just experiment with random elements: the
Construction Set not only lets you be the master of all you survey, but
you get to do the surveying, too.




Map OuTt Your P
PLaN Out Your MAP

Ifyou spend a little time before you begin considering what you want
your final map to look like, you probably will save yourself some
frustration and false starts (although a vote for an anarchic map can
be a compelling vote as well). Map-making is a challenge, and the
Construction Set has enough complexity and flexibility to com-
plement many approaches to the cartographer’s art.

Considerinadvance your basic look: flat, gently sloping, mountainous;
consider howwater can shape and define land. Do youwant dominant
black holes of urban sprawl or wide-open grasslands with scattered
farms? You could try a map with a tiny amount of money and the
same map with a huge amount of money to see how the territory
challenges your bank account. You could fill a barren terrain with
scads of running railroads and few people or have a teeming
population getting around only on skateboards—it’s a map of your
mind as well. However you design your map, keep in that mind the
integration of the fofal territory, from corner to corner, and off the
screen as well (remember those trains, planes and boats). Oh yeah—
have some fun, too.

ANS,

A-TRAIN CONSTRUCTION SET
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STARTING THE CONSTRUCTION SET

Light, God's eldest daughter,
is the principal beauty in a

building.

— Thomas Fuller

Please refer to your machine-specific addendum for system
requirements and installation information for the program. Unless
otherwise specified, screen shots are from the Macintosh version of
the program.

After you load in the Construction Set, you are presented with a
dialog box that has a list of example games and all of your saved A-
Train maps. The example games are explained under “Included
Scenarios.” For now, double-click on one of your saved games. On
the Amiga, click on a saved game and then on OK; we'll take a gander
at the Construction Set landscape. (See “Game Window (Amiga)” for
the Amiga opening screen.)

&5 Atrain ¥ ] = Macintosh HD

D) Flibbertigibbet [ T ]
0 Ghastly
D Great Shakes | Desktop |
O Transcendence
O whoops

[ Ccancel |

If you think it looks suspiciously like an A-Train screen, we’ll hand
you your hardhat now, but don't start hammering until you note the
new commands at the end of the Toolbar: all of the Financial and
Report window buttons have been replaced by map editing buttons
that activate the terrain building and destroying functions. Thereare
no Financial or Report windows in the Construction Set.




When any of the Map Edit command buttons are clicked, a window
with images of the chosen landscaping or building units will appear.
The individual editing commands can then be chosen with your
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mouse; they will have a highlighted box around them to indicate
their activation. (The CASH item works somewhat differently; see

below.)

You can then use your mouse cursor to select the map area you want
to transform. On the Mac, the windows can be moved around
onscreen by clicking and dragging their Title Bars; close them by
clicking in their Close Box. As in A-Train, you will be given grief by
all manner of message window advisors should you attempt wayward
construction efforts.

To jaunt around the terrain on the Mac, use the scroll arrows, boxes
and bars, and also the keyboard arrow keys. On the Amiga, you can
use the keyboard arrows, or, shades of A-Train, move the cursor to
any of the screen’s borders and it will change into an arrow pointing
in the direction your screen will scroll when you click or click and
hold on your left mouse button.

Map Terrain

Scroll Bar

Size Box

Train,
Track-Laying
and Help
Windows

Subsidiaries
Windows

' Map Edif
Windows
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MaiN MENU (MAC)
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As in Amiga A-Train, you can see more of your landscape by making
any active command windows disappear by hitting your right mouse
button or the plus or minus keys on the number pad; you can still use
the Map Edit and Subsidiaries commands with their windows
hidden. Most of the Amiga windows are closed by clicking on EXIT;
many Mac windows can be closed by hitting Return, which will
activate the EXIT button.

FILE

The File menu gives youaccess to the loading and saving opportunities
for Construction Set and A-Train scenarios, old and new.

OPEN SCENARIO brings up the selfsame dialog box seen when
you loaded the Construction Set, displaying any saved games
or example games, so you can tamper with their landscapes as
your whims decree. You will be prompted to save or not to save
any current map before your mouse can march across fresh
territories. You can get your trembling hands on any of the
original landscapes by opening them in A-Train and saving
them under a different name.

SAVE SCENARIO brings up the file-saving dialog box that lets you
rename the fileand direct its storage. Hitting SAVE without renaming
the file will bring up a dialog box seeking your assurance that you
indeed want to overwrite the existing file. (Let the saver beware!)

PAGE SETUP opens a dialog box that allows you to specify the
printer-specific options native to your printer for outputting
Construction Set maps.

PRINT MAP provides a dialog box for selecting printer specifics for
the Construction Set maps. The program will print out eight “tiling”
pages comprising your entire map territory. A key at the bottom of
each page identifies the scenario name, game date and time, and that
page’s placement in the tile composition.




QUIT quits the Construction Set. (It hurts us as much as it hurts
you.) You will lose changes to your map if you don't save them first,
using the Save Scenario command, before you leave the program.

EDIT

The Edit menu contains commands that are “ghosted,” or unavailable
for use. Theyare retained here to support the conventional Macintosh
interface.

OPTIONS

The Options menu allows you to customize the Construction Set to
suit your gameplay style.

TRAINS RUNNING, when checked, puts your Construction Set map
into operation, so that you can see if your terrain design is suitable
and vour rail operation smooth and coordinated. Map Edit com-
mands are inoperable while in thismode—the Toolbarwill disappear.

GAME SPEED brings up a window that lets you adjust the clock
speed of game events: train movement, time’s passage, etc. Click on
the Slowor Fast arrows for incremental adjustment or clickand drag
the scroll box for big speed bumpings.

PREFERENCES lets you toggle on or off the sound effects (when the
trains are set to run) of your rail operation, as well as the cycling of
light as day settles into night. Checkmarked boxes are on; click to
disable them.

WINDOWS

SHOW MAIN TOOLBAR, when checked, displays the
bar oficonsand buttons for bringing up the command
windows of the Construction Set. The toolbar can be
moved around onscreen by dragging its Title Bar and
closed by clicking in its Close Box.

SHOW SATELLITE VIEWWINDOW, when checked,

A-Train Construction Set
Preferences

(] Use Sound Effects
(] Do Day/Night Color Changes

=3

A-Train Comstruction et

i

displays a miniature version of your map landscape,

with a mouse-activated rectangle cursor that when

clicked will quickly scroll the main map display to
the area enclosed by the rectangle. Clicking on
highlighted train numbers in the registry will scroll
the landscape to the train’s place on the map.

Satellite Window and Map Terrain

A-TRAIN CONSTRUCTION SET
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GaAME WINDOW (AMIGA)

The Game Window opens automatically at startup. The submenus
and windows opened by the Game Window commands cannot be
moved around onscreen. The example maps are explained under
“Included Scenarios” at the end of this manual. You can access A-
Train's original landscapes by opening them in A-Train and saving
them under a different name.

orive: [Hork:A-Train Drawer |
rite: [Downfown Reorganizafien I

Amiga Game Window at Starfup
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LOAD SCENARIO is the default button selected when you load the
program, presenting you with a scrollable list of example games and
saved A-Train games, if they are in the current drawer. The current
drawer and path are found below this list. You can search for other
stored maps on other available drives by clicking on DRIVES.
Clicking on PARENT brings you up one level in the file-saving
hierarchy.

[,.-_,,_—>_ et o e i R
.
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Clicking on a file name in the scrolling list will highlight it and place
its name in the Drives ribbon at the bottom of the window. Click on
OK to bring up the desired map onscreen or on EXIT to leave the
window. The Load Scenario window will disappear after the file is
loaded, but can be accessed at any time—as well as all System
commands—by clicking on GAME on the toolbar.

SAVE SCENARIO brings up the Save Scenario window, which
displays the current path, names of already saved maps, and a
scrollable list of available drives (through the DRIVES button) for
map saving. You can type in a new name for an example map or a
previously saved map in the File ribbon at the window's bottom in
order to preserve your new map's changes and retain the old map as
well. Click on OK to fix the changes to disk or EXIT to leave the
window without any changes.

Who built the seven gates of
Thebes? In the books are listed
the names of kings. Did the
kings heave up the building
blocks?

— Bertolt Brecht

A-TRAIN CONSTRUCTION SET



GAME OPTIONS displays a window with settings to customize your
use of the Construction Set. GAME SPEED gives you the chance to
fine-tune the speed at which your game clock (and thus your train
operation) runs. You can choose to hear the rhythmic ditties of the
train’s passage by clicking on SOUND ON or you can keep the peace
by choosing SOUND OFF. DAY/NIGHT CYCLE ON/OFF switches
between landscape lighting reflecting light’s journey into night or
consistent sunshine.

All of these options are moot unless you click on TRAINS ON, which
will energize your empire, letting you test the track placement and
operation of your trains, which go through their paces of pickup and
delivery. You can see if the map under construction is suitable for
actual play. The game clock will run, as well as any trains, planes or
boats.

Letting vour trains loose automatically brings the Satellite window
down and also displays the Train Registry. You can toggle the
position of the Satellite window by hitting the right and left bracket
keys on the keyboard, and you can zero in on a particular train by
clicking on its number on the registry.

The financial operations of A-Train do not function in the Construction
Set, so you will not gain any profits or incur any losses. Consider this
a chance to go sightseeing on your map. (Map Edit commands will
not operate when the trains are “on.”)

PRINT MAP will give you a suitable-for-framing hard copy of your
Construction Set map. See your Amiga addendum for details.

CREDITS will bring up the names of the noble souls who toiled for
God, Country, and the Construction Set. (On the Mac, you can gain
this precious info under the Apple.)

QUIT quits the Construction Set. You must use the SAVE SCENARIO
command to save any changes to disk, or they will be lost. You can
cancel the operation by hitting EXIT.

10



TrAINS AND SuBsIDIARIES MENUS

TRAINS and SUBSIDIARIES have a set of commands and functions

that perform essentially the same as their counterparts in A-Train.
You can lay tracks, buy and place trains and stations, set schedules,

and arrange trunk lines to cities outside the map for export and ok Tﬁfl'-
import. The trains will not run until vou exercise that command r m—hﬂl'ng -~

option. You cannot make alterations to the map while in the “trains Windows
on” mode, though you can scroll.

The Construction Set lets you be a true Robber Baron of the old

school: all of the train purchases are free! However, you will be taxed

foryourrail assets once the game is loaded into A-Train. You can even '

buy and place two extra trains, #26 and #27, as long as their railroad Subsidiaries
lines are designed as trunk lines going off the map at two edges. The
trains on these lines cannot be purchased, sold, placed or removed
while playing A-Train, nor can their schedules be set. These are the
trains found in the original A-Train maps that couldn’t be scheduled
or tampered with. The Construction Set gives you much more
control over their placement and paths.

SUBSIDIARIES commands allow you to buy and place (or remove) ,

. . Map Edit
as many properties asyou please (well, 18 apiece, actually) sothat you Windows
can begin a game without having paid the pretty pennies of today’s
real estate market. After you choose the type of subsidiary on the Mac,
its command window allows vou to designate if you want the
buildings to be owned by you or the simulator by clicking on YOU or
COMP. (computer). The Amiga version buttons say YOURS and
SIMULATOR. The familiar “owner’s box” will appear on top of your
buildings.

Train, Track-Laying
and Help Windows Subsidiary Windows Map Edit Windows Game Clock and Funds

L8 fpr 81 Mon 8:09
 Cash 300, 868

T T T T T e M T ——

Amiga Toolbar

Assets designated as yours are added to your net worth and become
part of your A-Train Balance Sheet figures. Most Mac Subsidiaries
and Map Edit windows can be opened on top of other open windows,
which will then close.

A-TRAIN CONSTRUCTIONSET 11



Mapr EpiT MENUs AND FuNcCTIONS

PAINT LAND gives you six choices of terrain types that can either be
placed as a single unit by double-clicking on the designated block or
“painted” on the landscape by clicking on a block and moving the
mouse to define the new terrain placement.

Place the cursor in the middle of a block, click, and move the mouse
in any direction to highlight “strips” of blocks, or drag on a diagonal
for larger squares of territory. The highlighted rectangle that results
from this represents the area that will be replaced by the new,
selected terrain after you click the mouse again.

Mixed Woods

Woods

Mixed Fields

Fields

The terrain types are:

Level Land — terrain that is completely cleared of
any growth or development. (You can use this
command to erase mistakes and begin anew.)
Sea — a broad swath of water

Upfoun — mixed residential with small offices
and shops

Dountoun — combines Uptown with larger
commercial buildings

Mixed Woods — land irregularly interspersed
with clumps of trees

Woods — heavily forested terrain

Mixed Fields — grassy plots and bushes mixed
with cleared areas

Fields — grassy areas mixed with cultivated land,
orchards and clearings

12



Some elements cannot be painted over, such as mountains and
existing tracks and stations. For example, if you place a band of water
over a station with some large commercial developments nearby,
you will end up with “peninsulas” of track surrounded by water, with
the big buildings on “islands” of land. Actually, it can look rather

picturesque.

MOUNTAIN makes you king (or queen) of the hill by allowing you to
build towering slopes or gentle rises (or tear them down in a fit of
pigue). You are given two development choices, Small or Large, and
two options, Build or Remove. Selecting Small and then clicking on
ablock will result ina 2x2 square of raised land; Large produces a 3x3
plot. Both Small and Large mounts can be developed if you click
several times in succession on the slopes, raising the height of the
hills while only slightly spreading the hillsides laterally.

Selecting Remove lets you contour new or existing slopes; you can
click on the peaks to slice out sections so that the mountain’s apex
appears to have imploded, a la Oregon’s Crater Lake, or you can just
carve out crags. Ski buffs can make everyvalley heavenly. Other Paint
Land command choices have no effect on mountainous areas. You
can place mountains right up to the edge of buildings for a dramatic
cityscape; mountains cannot be placed on water.

TILE lets you place structural elements of the map block by block.
Just click once on the tile of your choosing and click on a site on the
map to place it. The 64 block choices include a range of farmland and
field units (including ranch houses and land with cows), woods thick
with trees or with lone stragglers, ponds, various types of residences
and small offices, larger offices, construction materials, roads, and
even crossroads.

You can “paint” tile elements in the manner of the Paint Land
commands by selecting a tile and drawing the cursor with the mouse
button depressed across the area youwant to transform. Broad bands
of tile images can be placed on the landscape. If you release the mouse
while laying the tiles, the painting will cease. You cannot paint tiles
over mountains, tracks and certain buildings.

You can cycle through the 4 sets of 16 tiles by clicking on the Page
Up or Page Down bars at the top of the block choices window. This
command allows you a nice degree of whimsy in your choices: you
can place a block of construction materials in the middle of a lake,
a mound of trees in the sea, or some nice condos in a pond. Plow a

A-TRAIN CONSTRUCTION SET
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road into the sea. Make some developments in league with the
Devil—who's to stop you?

RIVER places rivers, lakes or islands. Click on any of the three choices
toactivate them. Using River, you can drag the cursor over individual
blocks to place small stretches of water or cross the map with a
serpentine Nile. When you move the mouse over the proposed
riverbed, its highlight appears as a straight line, identical to that of
the track-laying highlight, but when the river is placed, its curves
and irregularities reflect its natural brethren. The rivers will fork and
break in some spots.

Putting a river into a larger body of water will sometimes result inan
unnatural looking “wedge” of water surrounded by strips of land at
the water’s joint. You can create a more smooth juncture at the
river’s mouth by painting that spot with the Sea choice in the PAINT
LAND menu or shape some irregular shorelines with the Island and
Lake commands.

If you choose Lake, you can place a 3x3 block of water surrounded by
a small amount of cleared land. You can place a succession of
contiguous lakes for larger bodies of water. Islands can only be placed
in lakes large enough to accommeodate them. Placing one in a small
lake will divide it into small strips of water with land in-between.
Placing anisland over other types of terrain will result in a 3x3 square
of cleared terrain.

If you place an island on the edge of a body of water, you can sculpt
the shore for an interesting eroded look. Rivers and lakes can be
placed over smaller buildings and residences, but not over large
commercial properties or through or over mountains. You can
design your rivers so that they easily accommodate bridges; laying
a river over existing track splits the river in two.

PORTS places seaports and airports. Selecting PORTS brings up a
two-choice display of an airport and a seaport, accompanied by a
Build and Remove command. You can even build a seaport in a lake,
but you won't make many shipping profits off a few trout—no boats
will float. The buildings on the seaport must be aligned close to at
least one block of land (not necessarily touching—just align the pre-
placed port’s highlight with at least one block of land before
placement). Removing a seaport replaces it with blocks of cleared
land.

14



If you try to place water over a seaport, the port
remains, but any attached land sinks beneath
the surface of the waves (a good place to start
looking for Atlantis). When you attempt to
place an airport or seaport, the cursor will
display a highlight of the port’s size and
alignment, but only a single highlighted block
when you click on the Remove command. You
can't place TILE objects on airports. You are
restricted to one airport and one seaport per
map.

If the seaport is built in waters open to the map’s edge, a freighter will
enter. The freighter will proceed straight from the bottom edge
towards the right edge of the map, but it won't be able to avoid
obstacles, so designasmooth passage if youwant to utilize ashipping
route. You can place an airport in water but you won't thrill your
passengers—no planes will arrive. It does look pretty at night,
though. First, put down two parallel strips of land an airport’s length
(nine blocks), and then place the building. You can delete the
remaining empty blocks for a clean look. Neither type of port can be
placed over mountains, certain tvpes of buildings, or tracks.

CASH allows you to configure your cash reserves withwhich to begin
a game. The + and — keys work much like the Bank Loan keys in
A-Train. You can increase the total in increments of either 1,000,000
or 100,000 dollars up to 9,900,000 dollars—enough to put those
silver cuspidors in every sleeper. This windowwill reveal the type and
size of your city, reflective of vour new development.

CLEAR lets you cut selections from the map. You can selectively
remove all of the trains, railroads, and mountains from vour map. If
you select All Trains, all of the trains you have placed or purchased
will be erased. All Railroads will erase all the railroads in addition to
all of the trains. However, the trains are merely removed from view
in this instance—they are “stored,” as when you use A-Train's
Remove Train command, and yvou can place them later.

The Clear All command gives you a fresh, clean map of flat land to
work with—a blank canvas upon which to paint a mapping
masterpiece. Thisalso erases all purchased trains, placed or not. This
is the command you should choose first if you want to construct a
completely original map.

Stupid Water Tricks

Small City well Balanced

Starting Money 8,400,000

g ) ¢

Clear All '

A-IRAIN CONSTRUCTION SET 15



BiTing THE BULLET

INCLUDED SCENARIOS

HELP! The button with the question mark will remain one of life’s
little mysteries—I couldn’t possibly be induced to reveal its secrets
... Oh, all right! Click on the question mark and you will see awindow
with icons of all game buttons, which, when clicked, will give you
sage advice on the use of that tool or command within A-Train and
the Construction Set.

Railroad Manager

Help Screen:

Hey, you're looking at it! Click on a
button to learn about that item and what
it does. For further details you can
always check the manual.

One of A-Train’s significant pleasures is making the Bullet Train
appear by successfully developing your city. However, the Construc-
tion Set gives you the chance to alter your maps so profoundly that
not even the mighty Bullet can penetrate your borders. Do not
completely surround your city by mountains if you want the Shin-
kansen to come—keep at least one side of the city open.

The Construction Set provides you with six example scenarios that
demonstrate a range of map-making options and concepts. You can
use some of them as a basis for actual gameplay, or just as prototypes
of design possibilities. Some of the maps have limited playability;
consider them candy for the eye.

16



Example 5 is a sort of terrain sculpture garden, a paint-by-numbers
combination maze/miniature golf course/labyrinth with a start and
a finish, but don’t ask us how to play. Example 6 is a train ballet: a
visual marvel of synchronicity and timing. The trains have an easy,
organic quality, almost a neural network of the brain at leisure—this
might scan well after a Long Island Iced Tea or two. (Hint: Don't try
to set any schedules with this one.) Take the inspiration of these
examples and make tracks!
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THIs LAND Is YoOur LAND

The A-Train Construction Set gives you the ticket to ride—on the
terrain of your own making. Every design decision is yours: Tilt your
train’s travel over perilous mountain passes carved by vour cursor.
Brighten up a drab landscape with an alpine lake, rustic ranchland,
columns of condos. Make subtle additions or subtractions—set a
doctor’s office in the foothills, angle an airport to your whim, remove
a length of unsightly roadwav—you control the horizontal, you
control the vertical.

The prospects are infinite; water worlds, gardens of greenery, urban
blankets or scorched earths—build the Land of 27 Trains or a
towering Himalaya no locomotive could traverse. You've got the
tools; make your mouse earn its cheese.

The created world is but a small
parenthesis in efernity.
— Thomas Browne
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TRAIN CATALOG

KIHA 40 — a diesel passenger train used on a local line in cold places.
Coaches: 2

Speed: 2 blocks/hour
Seats: 400

Price: 33,000 dollars
Passing stations: incapable

201— a commuter train with a large seating capacity.
Coaches: 3

Speed: 2 blocks/hour
Seats: 600
Price: 50,000 dollars

Passing stations: incapable

415 — a commuter train with a stainless-steel body. More suitable for suburban travel than a 201 model train.
Coaches: 3

Speed: 2 blocks/hour
Seats: 580

Price: 53,000 dollars
Passing stations: incapable

HOEEDHDOE
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205 — a commuter train used in a metropolitan city.
Coaches: 2

Speed: 3 blocks’hour  pledm
Seats: 440

Price: 46,000 dollars

Passing stations: incapable

""""" O O B 0 m o

211 — a stainless-steel suburban commuter train.
Coaches: 3

Speed: 3 blocks/hour
Seats: 640

Price: 70,000 dollars
Passing stations: incapable

AR — an electric commuter train with the largest seating capacity.
Coaches: 3

Speed: 3 blocks'hour S -

Seats: 700

Price: 80,000 dollars
Passing stations: incapable
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KIHA 82 — a super-express diesel passenger train.
Coaches: 2

Speed: 2 blocks/hour
Seats: 420

Price: 53,000 dollars
Passing stations: capable

113 — a direct-current electrical train used on suburban lines running by the sea.
Coaches: 3

Speed: 2 blocks/hour
Seats: 640

Price: 80,000 dollars
Passing stations: capable

FP 45 — a stylish suburban diesel express train.
Coaches: 3

Speed: 2 blocks/hour
Seats: 580

Price: 90,000 dollars
Passing stations: capable

381 — a super-express passenger train designed especially for running on curved lines.
Coaches: 2

Speed: 3 blocks/hour
Seats: 470

Price: 98,000 dollars
Passing stations: capable

EF 65-24 — a long-distance night passenger train that has a small seating capacity and high ticket fares.
Coaches: 3

Speed: 3 blocks/hour
Seats: 470

Price: 180,000 dollars
Passing stations: capable

AR [I1I — the most expensive but profitable passenger train.
Coaches: 3

Speed: 3 blocks/hour
Seats: 600

Price: 250,000 dollars
Passing stations: capable

KIN 30000 — a super-express passenger train with double deck coaches.
Coaches: 2

Speed: 2 blocks/hour
Seats: 460
Price: 50,000 dollars

Passing stations: capable
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NISHI 5000 — a super-express passenger train.
Coaches: 3

Speed: 2 blocks/hour
Seats: 600

Price: 80,000 dollars
Passing stations: capable

MEI 7000 — an express passenger train used for tourism.
Coaches: 3
Speed: 2 blocks/hour
Seats: 560

Price: 90,000 dollars
Passing stations: capable

DD 51 — a freight train.
Coaches: 2
Speed: 2 blocks/hour

s wrkee e

Price: 46,000 dollars -"‘-r-r- — gy il W 1-.1-1"'
Passing stations: capable

EF 62 — a freight train.
Coaches: 3

Speed: 2 blocks/hour
Materials: 4

Price: 76,000 dollars
Passing stations: capable

ED 76 — a freight train.
Coaches: 2

Speed: 3 blocks/hour
Materials: 2

Price: 73,000 dollars
Passing stations: capable

GP 40 — a freight train.
Coaches: 3

Speed: 3 blocks/hour
Materials: 4
Price: 116,000 dollars

Passing stations: capable
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